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1

1.1

1.2

Introduction

Document Description

Visual HyperScript (VHS) is a scripting environment for Ucam. It is designed to help
UcamX (and Ucam v10) users to automate all kinds of operator actions. Today, over
1500 commands are available. Visual HyperScript covers almost the entire
functionality of Ucam. The user can record simple repetitive tasks or he can build
complete applications with Launch Pads and interactive Dialogs. Scripting is fun and
can be done by people with any skill level.

The first part of the manual (Chapters 1 to 6) is designed to provide a basic Visual
HyperScript training for absolute beginners where they can learn how to:

0 Record UcamX actions into basic scripts

0 Add scripts to the VHS Menu

0 Run recorded scripts from the VHS menu
The second part (Chapters 7 to 17) is designed to provide a full Visual HyperScript
training to UcamX operators where they learn how to:

o Enhance scripts with Comments, Variables, Decisions and Loops

0 Add interactive & Startup Dialogs

o Create Launch Pads

0 Add basic Java code
The third part (Chapters 18 to 19) is for operators with programming skills where they
learn how to:

o Customize commands

o Create Standalone Scripts

o Add more complex java code

The fourth part (Chapters 20 to 21) contains a complete reference of the Visual
HyperScript Editor and Menu Editor.

The fifth part (Chapter 22) contains a set of demo scripts. The source code of the
scripts can be downloaded from the Ucamco website.

The last Chapter of the manual contains a Glossary where you can find more info on
the terminology used in this manual.

@ Note: This manual does not contain a reference section of the Visual
HyperScript scripting commands. The Visual HyperScript API
Reference Guide is available as a separate document and can be
accessed from the Visual HyperScript Editor Help menu

Who should use this Guide?

In order to use this Guide, you should have a fundamental understanding of PCB
fabrication and the UcamX CAM software.
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1.3

1.4

This Guide is to be used by:

a CAM operators

o Automation engineers

a Developers of software applications

About This Document

The following conventions are used in this document:

@ Note: Provides essential extra information.

@ Tip: Provides useful extra information.

©)] Example: Contains examples of file syntax, commands,
settings, etc.

A Warning: | Contains an important warning.

Other Available Documentation

Ucamco offers its customers a wide range of documentation on all its software,
including installation requirements and procedures, release information, detailed
task descriptions and info on customer support availability.

The following Ucamco documents are referenced in this manual:
o Visual HyperScript APl Specification
o UcamX User Interface Guide

Both documents can be found on the download page of www.ucamco.com

If you need more info please mail us at info@ucamco.com
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2

2.1

2.2

2.3

2.4

Situating Visual HyperScript

UcamX has 4 levels of automation, from basic level to advanced level.

Learns (Deprecated)

Recording of basic repetitive actions.
More information can be found in UcamX Help.

@ Tip: Learns are executed until stopped. In VHS you can simulate this behavior
by assigning the LOOP property to a script (see 15.3.2, 21.3.1 and 21.4.1)

Checklists (Deprecated)

Follow up of pre-defined procedures with limited UcamX functionality (80 commands).

More information can be found in UcamX Help.

Visual HyperScript

Easy scripting tool for non programmers providing nearly full UcamX functionality.

HyperTool

Scripting tool for experienced Java programmers providing full UcamX functionality.
The HyperTool APl Reference Guide can be found in the UcamX Help Menu.
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3 Installation

This section describes how to set up your computer to start using Visual HyperScript.

3.1 Requirements

o  Windows or Unix PC (see Ucamco Software Installation Requirements)
o Ucam v10.x or UcamX installed

3.2  Setting Up UcamX for using Visual HyperScript

Running Visual HyperScript requires the following ucam.db keys to be set:

vhs.home
Contains the path to the Visual HyperScript Home directory.
Default: HOME:/vhs

vhs.script.path
Contains a path to a VHS script directory used by import & run commands (see 12.3)
Default: HOME:/vhs/scripts

vhs.init.scripts
Contains a path to a VHS script directory containing custom commands (see 18.4)
Default: HOME:/vhs/init

All options set in the Option panel can also be set using ucam.db keys (see 20.2.4)
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4 Getting Help

This section describes how to get help when using Visual HyperScript.

Visual HyperScript Help

Accessible via the Help > On Application > Main Menu Bar > HyperScript menu
option in UcamX . You can also use the Help > On Context > HyperScript and
select any menu option to get help on the selected menu option.

Visual HyperScript APl Reference Specification
A link to the APl is included in the Help page for the VHS Editor.

Visual HyperScript demo Jobs & Scripts

Some VHS demo jobs & scripts can be downloaded from our website.
More info can be found in chapter 22.

Ucamco Customer Support

Send all HyperScript issues to hyperscript@ucamco.com

See also Customer Care info on page iii
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5 Getting Started

This chapter is for absolute beginners.
Here we learn how to record and run a basic script.

5.1 Recording a Basic VHS Script

1 Prepare UcamX for recording a script.
e.g. to record a script that performs a specific action
on the top copper layer in plane 1 you must:

a Openajob

o Set the top copper layer to plane 1

Select Visual HyperScript Editor from the HyperScript menu

Click LI on the VHS Editor menu bar to create a new empty script

Click # to start recording

Perform the UcamX actions that need to be recorded

Each UcamX action is recorded as a command line in the script Window

a b~ W DN

Click  to stop recording
Click '=. to save the script as MyFirstScript

Click LE to add the script to the HyperScript menu
Close the Visual HyperScript Editor using the Exit option on the File menu

© 0o N O

5.2 Running a Basic Recorded VHS Script

1 Prepare UcamX for running the recorded script.
e.g. to run a script that performs a specific action
on the top copper layer in plane 1 you must:

a Openajob
a Set the top copper layer to plane 1

2 Select MyFirstScript from the HyperScript menu
and watch the script being executed
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6 Managing Saved Scripts

In this chapter we learn how to use the VHS Editor to manage saved scripts.

6.1 Updating a Script

To add/edit commands, comments, variables, decisions and loops
1. Select Visual HyperScript Editor from the HyperScript menu

Click ==* to open a saved script file

Place the cursor on line 1 in front the firtst command
Press the Return key

Type “// This is a recorded script” (without the quotes)

S e

Click File >Save or |5l to save the script
To save the script using a new name see 6.3

@ Tip: During editing press Ctrl+Space to see a list of all possible commands.
If you type the first characters of a command, Ctrl+Space will show all
commands beginning with the characters you have typed. This auto
complete function allows you to select any command out of the displayed list.
It is up to you to replace the dummy parameters with suitable values.

@ Note: Commands that have a correct syntax are color coded. This gives you a
visual feedback in case you have misspelled a command name.

6.2 Adding UcamX Actions to a Script

To add new UcamX actions to a saved script we (re)use the Record function:
1 Click = to open a saved script file

1 Place the cursor in the script at the location
where the new command(s) need to be inserted

Click # to start recording
Perform the UcamX actions that need to be recorded

Click  to stop recording

ga b~ WN

Click [=] to save the script
To save the script using a new name see 6.3

6.3 Renaming a Script

To rename saved/updated scripts:

1 Click = to open a saved script file
2 Click File > Save As... to save the script using a new name

3 Click LE if you want to add the script to the HyperScript menu
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@ Note: To remove the old script name from the HyperScript menu
you need to use the VHS Menu Editor (see 21.2)

6.4  Deleting a Script

A saved script cannot be deleted using the VHS Editor.
You need to use the file manager from your operating system to remove the file.
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/ Enhancing Recorded Scripts

A basic recorded script can only replay the recorded actions. In the next chapters
we look at how to extend the functionality of recorded VHS scripts by adding:

Commands & Java Code

VHS commands and Java code is manually added to provide more functionality
Chapter 8 explains how to add VHS commands and Java code

Comments

Comments are used inside a script to provide information about the script.

Chapter 9 explains how to enter comments.

Variables

Variables are used inside a script to store information. This information can be used
during the execution of the script

Chapter 10 explains how to define and use Variables.

Interactive Dialogs

Interactive Dialogs are used to exchange information with the user during the
execution of a script.

Chapter 11 explains all types of dialogs.

@ Note: Startup Dialogs can use the same dialog types (see Chapter 17)

Flow Control

Flow Control instructions are standard java instructions used to break up the flow of
execution of a script to allow conditional execution of certain blocks of code.

Chapter 12 explains how to use flow control to optimize your scripts
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8 Enhancing Scripts — Commands & Code

8.1  Writing VHS commands

There are more than 1500 VHS commands available, most of them are recordable.

Some of the recordable VHS commands also have a variant with a different parameter
set (e.g. one command with object coordinates and the same one with x,y
coordinates). To record this variant, you can change a record mode parameter in the
optionpanel of the VHS Editor. If the command with the required parameter set cannot
be recorded by changing the record mode than you will need to enter the command by
hand (see updating scripts 6.1)

@ Note: All VHS commands are described in the Visual HyperScript API
Specification. This document is part of the VHS documentation set
and is also accessible from the HyperScript help page.

8.2  Writing Java code

Visual HyperScript is a full option scripting language based on Java. So it is possible
to write scripts that use the full functionality of the Java programming language
including complex mathematics and user interfaces. Variables need to be typed.

It is beyond the scope of this document to provide detailed info about the Java
language. Please consult the Oracle site for more information.

http://download.oracle.com/javase/tutorial/java/index.html

If the HyperScript environment has not enough power to satisfy your automation
needs than you can always switch to HyperTool, Ucamco’s high-end automation
product. More info can be obtained by sending your inquiry to hypertool@ucamco.com
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9 Enhancing Scripts — Comment

9.1 Intro

Comment is hon executable descriptive text added by the script writer.
Comment is shown in green.

It is advisable to add lots of comment to your scripts:

o To make sure that anyone can understand your script

o To facilitate future maintenance on the script

o To help you find info (e.g. matching brackets if the nesting becomes complex)

9.2 Syntax

Single line comment

// This is a single line of comment

Comment can also be added at the end of a command line e.g.

apeCreateCircle(1,0.75); // Create a circle aperture

Multi line comment

/* This is an example of

multi line comment */

This type of comment is used to document the parameters of a function

/‘k*
* Create Circle aperture
*

* (@param apeNum Aperture Number
* @param dia Diameter

*/

In-line comment

apeCreateCircle (1l /* ape number */ ,0.75 /* ape size */);
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10 Enhancing Scripts - Variables

10.1 Intro

Variables are containers to store values during the execution of a script.

A Variable can be:

a

a
a
a

Used for calculations

Used for branching

Printed to the console window
Displayed in a Prompt Dialog

Visual HyperScript has 4 kinds of Variables:

]

a
a
a

Program Variables
Pre-defined Variables
Environment Variables
Ucam.db Keys

10.2 Program Variables

Program Variables are user defined Variables to be used in the script.

10.2.1 Typing Variables

Visual HyperScript is a loosely typed scripting langue. It means that in most cases
there is no need to specify the type of a Variable. VHS uses the context of the

command to decide which type to assign to a Variable.

Java: double dAbc = 123.456; // dAbc must be typed as double

HyperScript:

10.2.1.1 Javatypes used in VHS

dAbc = 123.456; // dAbc will be typed as double because 123.456 has decimals

Type Description & Assignment
Boolean true or false
bVar = true;

Using a promptBoolean command (see 11.4.6)

String Text characters

sVar = “This is a string”;

Using a promptString command (see 11.4.4)

Using a promptOption command (seel1.4.6)
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Using a promptFileName command (see 11.4.10)

Option List

List of strings
oVar = [{ “option_1", “option_2"}];

Integer

Whole Number
iVar = 123;
Using a promptinteger command (see 11.4.7)

Double

Number with decimals
dVar = 123.456;
Using a promptDouble command (see 11.4.8)

Double Unit

Number with decimals and unit
Use the prompt Unit command to set a unit value (see 11.4.9)

10.2.1.2 HyperScript types (classes)

Type

Description & Assignment

Arc

Using 3 points and sense
aVar = Arc (Point pFrom, Point pTo, Point pCenter, String sSense)
Using 6 coordinates and sense

aVar = Arc (double dFromX, double dFromY, double dToX, double dToY, double
dCenterX, double dCenterY, String sSense)

Using 6 coordinates, sense and units

aVar = Arc (double dFromX, double dFromY, double dToX, double dToY, double
dCenterX, double dCenterY, String sSense, String sUnits)

Using a copy of an existing arc (aMyArc)
aVar = Arc (Arc aMyArc)

Point

Using X and Y coordinates with unit

pVar = Point(double dX, double dY, String sUnits) ;
Using X and Y coordinates without unit

pVar = Point(double dX, double dY) ;

Using a copy of an existing point (pMyPaint)
pVar = Point(Point pMyPoint) ;

Using a promptpoint command (see 11.4.11)

Using a pickPoint command (see 11.5)

Line

Using X and Y coordinates of “from” and “to” point with unit

IVar = Line(double dFromX, double dFromY, double dToX, double dToY, String
sUnits);

Using X and Y coordinates of “from” and “to” point without unit
IVar = Line(double dFromX, double dFromY, double dToX, double dToY);
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Using “from” and “to” points without unit

IVar = Line(Point pFrom, Point pTo);

Using a copy of an existing line (IMyLine)
IVar = Line(Line IMyLine);

Using a promptLine command (see 11.4.12)

Using a dragLine command (see 11.5)

Rectangle

Using left bottom and right top points
rVar= Rectangle(Point pPoint1, Point pPoint2) ;
Using rectangle boundaries and unit

rVar = Rectangle(double dXmin, double dYmin, double dXmax, double dYmax, String
sUnits);

Using rectangle boundaries without unit

rVar = Rectangle(double dXmin, double dYmin, double dXmax, double dYmax) ;
Using a copy of an existing rectangle (rMyRect)

rVar = Rectangle(rMyRect)) ;

Using a promptRectangle command (see 11.4.13)

Using a dragRectangle command (see 11.5)

10.2.2 Assigning a Value to a Variable
0 Using a manual assignment

sJobName = "MyJob";
0 Using a dialog function (see chapter 11)

sName = promptString("Name:", "Enter here your name");

o Using a VHS command

e.g. to obtain the value of the current job:
sJobname = jobName () ;

@ Tip: VHS has lots of get/set commands:

- the command without parameter gets the value
- the command with parameter sets the value

10.2.3 Obtaining/Displaying the Value of a Variable

0 Using a print to console command

print ("Distance between ptl and pt3: " + dDist);
0 Using a dialog function (see chapter 11.3)

viewWarning (iReturnCode) ;
O Using single line print commands in the VHS Editor (see xxx)

print “Name: “ + sVar; print “Number: “ + iVar;
0 Using the Variables Window of the VHS Editor during debugging (see 20.2.5)
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10.3 Using “methods” on variables

Variables, used in scripts, often need some processing. For each variable type there
are a number of functions (methods) available.

10.3.1 For Javatypes

e.g to find the location of character “a” inside a string sMyString you can use the
command: sMystring.indexOf (”a”);

All methods for Java types can be found in the Java API
http://www.oracle.com/technetwork/java/javase/documentation/api-jsp-136079.html

10.3.2 For VHS types

All methods for HyperScript types are found in the Classes section of the VHS API.
Examples can be found in the Demo Scripts (See Chapter 23)

10.4 Pre-defined Variables

10.4.1 Visual HyperScript file info Variables

Name Type | Value
FILE_TYPE int 0
FILE_PARENT int 1
FILE_ATTRIBUTES int 2
FILE_SIZE int 3
FILE_MODIFICATION_DATE | int 4
FILE_NAME int 5

The fole info Variables have a fixed value. They are used to index the objectlist
returned by the getLayers() command. Each index retrieves its corresponding value.

Examples

To retrieve layer info for all layers:

list = osGetFileList ("C:\\Windows\\Web\\Wallpaper\\Windows"™, true);

int counter = 1;

path = forEachItem(list) {
print ("---- File " + (counter++) + " ----");
info osFileInfo (path);

print (' type " + info[FILE TYPE]);
print (" parent " + info[FILE PARENT]);
print (' attibutes " + info[FILE ATTRIBUTES]);
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print (" size " + info[FILE SIZE]);
print (" modification date " + info[FILE MODIFICATION DATE]);
print (" name " + info[FILE NAME]);

}

To get the file name of the 3th file in the list:

osFileInfo (list[2]) [FILE NAME];

10.4.2 Visual HyperScript layer info Variables

Name Type | Value
LAYER_NAME int 0
LAYER_CLASS int 1
LAYER_SUBCLASS int 2
LAYER_ATTACH int 3
LAYER _INDEX int 4
LAYER_ACTIVITY int 5
LAYER_APERTURES int 6

The layer info Variables have a fixed value. They are used to index the objectlist
returned by the getLayers() command. Each index retrieves its corresponding value.

Examples

To retrieve layer info for all layers:

int counter = 1;
info = forEachItem(getLayers()) {
print ("---- Layer " + (counter++) + " —-——=-");
print name " + info[LAYER NAME]);
print class " + info[LAYER CLASS]);
print subclass " + info[LAYER SUBCLASS]);

(ll
("
("
print (" attach " + info[LAYER ATTACH]);
(ll
(ll
("

print index " + info[LAYER INDEX]);
print active " + info[LAYER ACTIVITY]);
print active " + info[LAYER APERTURES]) ;

To get the activity status of the second layer:
getLayers () [1] [LAYER ACTIVITY];

To get the number of apertures of the first layer:
getLayers () [0] [LAYER APERTURES];
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10.4.3

10.5

@ Note: The index count starts with O.

VHS Debugger Variables.

El Conzale OptionPanel | = Yarables 23

M ame | " alue |
Currentlay layer 'z
Currenttpe 18=CIR.1.1
Currentdbject not available

These Variables provide essential feedback during debugging of a script
avoiding the need for extra print instructions in the script.

Ucam.db Keys

Visual HyperScript can get/set Ucam.db key values.

The db keys can hold values of 6 different types:
String, Boolean, Integer, Double, Unit Value and Path

@ Note: The Path type is processed in VHS as a String
There is a command for each Variable type.
To get the value of a key

e sVar = dbString(String dbKey);

e bVar = dbBoolean(String dbKey);

e iVar = dbinteger(String dbKey);

e dVar = dbDouble(String dbKey);

e uVar = dbUnitValue(String dbKey);

e sVar = dbPath(String dbKey);

To set the value of a key
¢ dbString(String dbKey, String sVar);
e dbBoolean(String dbKey, Boolean bVar);
o dbinteger(String dbKey, Integer iVar);
e dbDouble(String dbKey, Double dVar);
e dbUnitValue(String dbKey, Double uVar);
o dbPath(String dbKey, String sVar);

@ Example: sVHSHome = dbPath("vhs.home");// get ucam.db key
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10.6 Environment Variables

Visual HyperScript can retrieve the value of operating system environment Variables.

Example
To load & print the location of your temporary storage location into a Variable:

myTemp = envString ("TEMP");
print (myTemp) ;

The console window shows the path:
C:\Temp

$~ Note: There are also osCreateTmpDir and osMarkAsTmp commands
available to create & mark temporary storage locations
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11 Enhancing Scripts - Dialogs

11.1

11.2

11.3

Intro
Scripts have several ways of exchanging information with the user during the
execution of a script:

e Print — Print a message to the Console Window

e Warning — Display a simple message with a OK button

e Prompt — Display & request any type of Variable information.

e Pick & Drag — Request for Point, Line or Rectangle coordinates

¢ Run - Branch to another script

Print

The print command can be used during the execution of a script to write feedback to
the Console Window. The print command is in fact a BeanShell command. That is why

it is not in the VHS command list and why it does not use color coding. The “+”
character can be used to join text and Variables.

print ("The current job is " + jobName()) ;

El console 53 | b4= variables OptionPanel % R = - =0
Ucam's message window
The current job is multi

Warning

The warning command is used to display a text message on screen until the OK
button is pressed. Meanwhile the script continues to execute. As long as the OK
button is not pressed, all consecutive warnings will be added to the same dialog.

viewWarning ("Welcome to HyperScript");

-

r Warning

! "_»., YWelcome to HyperScript

@ Note: viewWarning can not be used in Standalone Scripts (see 19.8),
use the promptLabel command instead.
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11.4 Prompt

A prompt sequence halts the execution of the script and displays a dialog on screen.
The user can perform any UcamX action, including entering/selecting values in the
dialog, before clicking

e The Continue button to continue the execution of the script

e The Abort button to stop the execution of the script.

@ Tip: The [Esc] key can also be used to abort a script

A prompt sequence consists of a promptStart command, a promptEnd command
and, in between, any number of the following prompt commands:

e promptLabel

e promptString

e promptOption

e promptBoolean
e promptinteger

e promptDouble

e promptUnit

o promptFileName
e promptPoint

e promptLine

e promptRectangle

The following sections describe all elementary prompt commands. Each prompt
sequence contains 1 single prompt command. The Demo Chapter contains an
example of a Prompt Dialog which uses all possible prompt commands

(see 22.9).

11.4.1 PromptStart

The prompStart commands initiates a prompt dialog.

It is also possible to specify :

O a parameter set name
parameter sets can save a set of parameters for later reuse
for an example of a dialog with a parameter set see 22.9

a adialog name
for an example of a dialog with a dialog name see 11.4.3

promptStart ("MyParSet", "Welcome") ;

;~ Note: The parameter set and dialog name are optional
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11.4.2

11.4.3

11.4.4

PromptEnd

The prompEnd commands closes a prompt dialog.

PromptLabel

A promptLabel command adds one or more text lines to a Prompt Dialog box.

promptStart ("","Welcome"); // Dialog name "Welcome"
promptLabel ("Welcome to HyperScript");
promptLabel ("The easy solution to automate Ucam");
promptEnd () ;

L T

'M Welcome

Welcome to HyperScript
The easy solution to automate Licam

| Continue “ Abort

PromptString

A promptString command adds a text label and text entry field to a Prompt Dialog box.
The entered value is assigned to a string Variable (sVar).

promptStart () ;
sVar = promptString("Name:", "Enter here your name");

promptEnd () ;

-

"1 Visual HyperScript Prompt

)

Mame: |[Enter here your name| -

’ Continue ” Abort ]

11.4.5 PromptOption

Visual HyperScript User Manual

A promptOption command adds a text label and a selectable drop down field to a
Prompt Dialog box. The selected value is assigned to a string Variable (sVar).

@ Tip: Your code is more easy to read if you use a Variable (e.g. oDef) to
define the option values at the start of your script

oDef = [{"Please select","Male","Female"}];

promptStart () ;
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11.4.6

11.4.7

sVar = promptOption("Sex:", oDef, "Please Select");

promptEnd () ;

"1 Visual HyperScript Prompt

Sex. |Please select [V

Please select
hale
Female %

’ Continue ” Abort ]

PromptBoolean

A promptBoolean command adds a text label and a check box to a Prompt Dialog box.

The state of the check box is assigned to a boolean Variable (bVar).

promptStart();
bvar = promptBoolean ("Accept", false);
promptEnd () ;
"4 Visual HyperScript Prompt
Accept []
[ Continue ” Abhort ]

Promptinteger

A promptinteger command adds a text label and an integer number entry field to a
Prompt Dialog box. The entered value is assigned to an integer Variable (iVar).

promptStart () ;
iVar = promptInteger ("Integer:", 123);

promptEnd () ;

"1 Visual HyperScript Prompt
Integer; 123|
’ Continue ] ’ Abort ]

29
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11.4.8

11.4.9

11.4.10

PromptDouble

A promptDouble command adds a text label and a decimal number entry field to a
Prompt Dialog box. The entered value is assigned to a double Variable (dVar).

-

"4 Visual HyperScript Prompt

Double: | 123.456

Continue ] ’ Ahort ]
promptStart();
dVar = promptDouble ("Double:", 123.456);
promptEnd () ;
PromptUnit

A promptUnit command adds a text label and a decimal number entry field to a
Prompt Dialog box. The entered value is assigned to a unit Variable (uVar), a double
Variable using the unit supplied in the prompt command. If you change the current unit
(e.g from mm to mil) the Variable will be converted to the changed unit.

@ Note: The unit is not entered or displayed in the entry field.

promptStart () ;
uVar = promptUnit("Double Unit:", 123.456, "mm");
promptEnd () ;

" Visual HyperScript Prompt "1 Visual HyperScript Prompt
Double Unit: 123456 Double Unit: | 4860.472|
Continue ||  apont | | continue || apot |
promptUnit with current unit “mm” promptUnit with current unit “mil”

PromptFileName

A promptFileName command adds a text label, a text entry field and a file selector
icon to a Prompt Dialog box. The entered value is assigned to a string Variable (fVar).

promptStart () ;
fvar = promptFileName ("File Name:", "");

promptEnd () ;
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-

"4 Visual HyperScript Prompt

File Mame: | CAlcamcoillcamatibin

’ Continue ” Abort ]

11.4.11 PromptPoint

A promptPoint command adds point coordinate (X,Y) entry fields and a Pick button to
a Prompt Dialog box. The entered values are assigned to a Point Variable (pVar).
The user has 3 ways to enter the coordinates:

o Accept the default coordinates and click Continue

o Enter new (double) coordinates and click Continue

o Click the Pick button, click a location in the main window and click Continue

promptStart () ;
pVar = promptPoint ("Point", Point (100, 150));
promptEnd () ;
"4 Visual HyperScript Prompt
Paint 3¢ 100] v 150

’ Continue ” Ahort ]

11.4.12 PromptLine

A promptLine command adds start point (X1,Y1) end point (X2,Y2) entry fields and a
Drag button to a Prompt Dialog box. The entered values are assigned to a Line

Variable (IVar).
The user has 3 ways to enter the coordinates:
o Accept the default coordinates and click Continue
o Enter new (double) coordinates and click Continue
a Click the Drag button, drag a line in the main window and click Continue

promptStart () ;
lvar = promptLine ("Draw", Line(0, 0, 100, 250));
promptEnd () ;
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11.4.13

11.4.14

11.5

-

"4 Visual HyperScript Prompt

Draw 31 0 v1 |0 iad

¥2 100 Y2 | 250 o

[ Continue ” Ahort ]

PromptRectangle

A promptRectangle command adds left bottom point (X1,Y1) end right top (X2,Y2)
entry fields and a Drag button to a Prompt Dialog box. The entered values are
assigned to a Rectangle Variable (rVar).
The user has 3 ways to enter the coordinates:

o Accept the default coordinates and click Continue

o Enter new (double) coordinates and click Continue

o Click the Drag button, drag a rectangle in the main window and click Continue

promptStart();
rVar = promptRectangle ("Rectangle", Rectangle(-50, 150, -50, 300));
promptEnd () ;
"4 Visual HyperScript Prompt
Rectangle ¥min |-50] ‘ein -50
Arnax [ 1450 frnEs | 300

[ Continue H Ahort ]

Combining Prompt Commands into 1 Dialog
Any number of prompt commands can be combined in a Prompt Dialog.

To find out how, please have a look at the Showing all “Promptable” Variable
Types demo script in chapter 22.9

Pick & Drag

The promptPoint, promptLine and promptRectangle commands are not the only
way to get Paint, Line and rectangle coordinates.

During a script execution it is also possible to ask a user for Point, Line or Rectangle
coordinates without displaying the coordinate values. This can be done using the
pickPoint, dragLine or dragRectangle command. Each function halts script
execution, shows an Information window* and waits for user interaction.
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"4 Information " Information " Information

\i‘) Click on a point i i i

*The display of this info Dialog can be set/reset in the Option Panel (see 20.2.4)
Hide Info Dialog

@ Example 1: Use pick & drag commands to load coordinates into Variables

pVar = pickPoint("Click on a point"); //Get Point coordinates
1lVar = dragline("Drag a line"); //Get Line coordinates

rVar = dragRectangle ("Drag a rectangle"); //Get rectangle coordinates

@ Example 2:Use pick & drag commands to insert objects

// Insert flash with current aperture

// on picked X,Y coordinates

insertFlash (pickPoint ("Click on a point"));

// Insert draw with current aperture

// using dragged X1,Yl and X2,Y2 coordinates
insertDraw (dragLine ("Drag a line"));

// Insert rectangular polydraw with current aperture
// using dragged Xmin,Ymin and Xmax,Ymax coordinates
insertPolydrawRect (dragRectangle ("Drag a rectangle"));
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12 Enhancing Scripts - Flow Control

12.1 Intro

Flow Control instructions are standard java instructions used to break up the flow of
execution of a script to allow conditional execution of certain blocks of code.

We have 3 types of flow control statements:

o Decision making statements

Q Branching statements

0 Loop commands

12.2 Decision making statements

Java
a if-then
o if-then-else
o switch

12.3 Branching statements

Java
o break
o continue
a return

Detailed information about java flow control statements can be found on the site of
Oracle, owner of the java language

http://download.oracle.com/javase/tutorial/java/nutsandbolts/flow.html

HyperScript
a importFile
Import an external script file and continue when it is finished
for an example: see 0
Q importScript
Import and run a list of semicolon separated VHS commands

:C- Note: The code is executed inside the current environment, so you can
access Variables and functions defined in the external script after the
import command has been completed.

A Warning: Imported code cannot be debugged using HyperScript Debugger.
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12.4

12.4.1

12.4.2

12.4.3

a runFile
Run an external script and continue when it is finished
for an example: see 22.3.3

Q runScript
Run a number of HyperScript commands separated by a semicolon

@ Note: The code is executed outside the current environment (Variables will not
be affected), however the script gets a copy of all current Hyper-Script
Variables, so it is possible to pass arguments.
Jobs, layers etc. may be changed by the external script, so using the
runFile or runScript command in a forEachLayer loop may result in
unpredictable results.

Loops

Intro

Loops are used to repeat a block of code or even entire scripts.

Visual HyperScript has 3 types of loops:

o Standard Java loops in scripts

o VHS Loops in scripts

o LOORP flag in dialogs (see 21.3.1, 21.4.1 and 15.3.2)

Standard Java Loops

a for
o while
a do while

Detailed information about java loops can be found on the site of Oracle,
owner of the java language

http://download.oracle.com/javase/tutorial/java/nutsandbolts/flow.html

For an example of a while loop: see 22.12

VHS Loops

Visual HyperScripts adds a very specific loop, the forEach loop.

The forEach loop is used to access each successive item in a collection of items.
These items can be layers, apertures, objects, objectlists, nets, ....

HyperScript has 16 custom forEach loop commands

o forEachJobNet
a forEachLayerNet
a forEachLayer
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forEachDrill
forEachExtra
forEachSignal
forEachApe
forEachObject
forEachltem
forEachNet
forEachinRectangle
forEachRegion
forEachFlash
forEachDraw
forEachArc
forEachVixt

00000000000 OO

forEach commands for Integr8tor and Panel Editor
forEachi8job

o forEachPElnputJob

o forEachPEPanelJob

o forEachPESolution

O

;_ Notes: forEach commands are not recordable

@ Tip: Allways check if there is a variant of a specific forEach command before
using the generic command without parameters. e.g. the forEachDirill
command has a generic form without parameters and another with
parameter subclass. Using the subclass parameter could save you the effort
of having to test for the subclass in the script.

12.4.3.1 Nesting of forEach Loops

Use the following simplified nested forEach loops as a guideline for making your own
nested structures. The “|” character means that you can choose between multiple valid
options.

forEachlLayer | forEachDrill | forEachExtra | forEachSignal {
// vhs commands
forEachApe {
// vhs commands
forEachObject | forEachInRectangle {
// vhs commands
forEachRegion | forEachFlash | forEachDraw | forEachArc | forEachVtxt {

// vhs commands
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12.4.3.2 Examples

12.4.4

@ Example 1: forEachApe and forEachDraw

// print the start and end coordinates of all selected draws
forEachApe () {
forEachDraw () {
if (objSelect()) {
print (objFromPoint () + " " + objToPoint());

}
¥
¥

@ Note: The enclosing forEachApe loop is necessary to make sure that
the aperture used for the selected draw is marked as current.

©) Example 2: forEachNet

// Select all objects of net iNet on layer in plane 1
i0bjCount = 0;
iNet = 20;
forEachNet (iNet) {
objSelect ("+");
objCount++;
}
print (iObjCount + " object(s) of net " + iNet + " selected.");

@ Examples 3 & 4: forEachltem

// Print all items of an objectlist

iCounter = 1;
sItem = forEachItem([{"CIR", "REC", "BOX", "COM", "THE"}]) {
print ("Item " + (iCounter++) + " is " + sltem);

}

// Get and print all layer names

int counter = 1;
item = forEachItem (getLayerNames ()) {
print ("Layer name " + (counter++) + " is " + item);

}

@ Notes: More examples can be found in the Demo Scripts (see Chapter 22)

LOOP flag in Dialogs

When adding a script to a Launch Pad, it is possible to set the loop flag in the Item
Properties of the script. This way the script will keep on looping until the user clicks the
abort button (or presses the Esc key) on any script dialog (see 21.3.1, 21.4.1 and
15.3.2)
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13 Best practices

13.1

13.2

Naming conventions

For Variables

Variables do not need to be typed but you can make life easy by prefixing each
Variable name with its type. This way you always know the type of a Variable.
Variable name prefixes
a String: s —e.g. sVar, sName ...
Option: 0 — e.g. oVar, oState
Boolean: b — e.g. bVar, bAccept
Integer: i — e.qg. iVar, iAge
Double: d — e.g. dVar, dAmount
Unit: u — e.g. uVar, uLength
Point p — e.g. pVar, pFlash
Line | — e.g. IVar, IDraw
Rectangle r — e.g. rVar, rArea
Arc a— e.g. aVar, aMyArc
FileName: f — e.g. fVar, fReadme

00000000 oo

;~ Note: A filename is a string with a special format.
Therefore you can also use s

For Scripts, Custom Commands and Packaged Launch Pads

Try to use a consequent naming scheme.

Feedback

Use print commands to display information about the script during execution. Never
give the operator the impression that the script is hanging while in fact it is
performing a time consuming forEach loop. Write some feedback to the console
window so the Operator knows that everything is still OK.

Print commands used for debugging can be left in the script as comment.
This can be useful in case of future updates.

@ Note: You do not always need to put a print command inside your script. During
debugging you can use the VariablesView window in the VHS Editor to
examine the value of a Variable (see 20.2.5) or you can use single line
print commands (see 14.3).

@ Tip: Write lots of comments!
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14 Debugging VHS Scripts

14.1

14.2

14.3

The VHS Editor has a build-in script debugger.

Buttons

Icon | Description

i Start debugger

g Stop debugger

b4 Step into

4 Run next step

4] Run to line with cursor
il Hold execution

= Terminate script

The Variables Window

The Variables window in the VHS Editor displays the value of customer defined
Variables and pre-defined Variables (CurrentLay, CurrentApe and CurrentOpbject)
during debugging of a script. The window can be made visible using the Windows >
Variables option or the keyboard shortcut Ctrl+Alt+V

Single Line Scripts
The button bar has a drop down list containing single line scripts (i.e VHS commands
separated by a semicolon)
Each single line script can be executed by selecting it from the drop down list
e Before a script is started
e During a debug stop
e After execution of a script

This can be used e.g. to print info to the console window instead of putting
the print commands hardcoded inside the script.

@ Note: Single line scripts can also be executed using the importScript and
runScript command (seel2.3)
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15 Editable Launch Pads

An Editable Launch Pad is a dialog window from which you can launch personal scripts.

15.1

15.2

15.3

15.3.1

Create an Editable Launch Pad

Open the VHS Menu Editor

Add a menu item

Set Type to Editable Launch Pad

Enter a menu item label

Click OK to accept menu item properties
Click OK to accept the menu item

O OBk~ WN PP

At this point we have created an empty Launch Pad.
The next step is to open this Launch Pad and to add Sections & Buttons.

Open an Editable Launch Pad

You can open Editable Launch Pads from the HyperScript menu.

Add items to an Editable Launch Pad

The right mouse button can be used to add:
o Sections
a Buttons

Add a Section

Section Properties
Section Title
MySectiun|
[ Ok ] [ Cancel
Section Title Name of the inserted section
OK Accept current Section Properties
Cancel Cancel the Section Properties Dialog

To add a section, right click inside a Launch Pad and select Add Section...
To change a section title, right click inside a section and select Section Properties...

To delete a section, right click inside a section and select Delete Section
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15.3.2 Add a Button

¥ Ty

"2 Button Properties

Buttan Propeties

Label |Top

[]lcon |

Secript hameHSvscripts'True Colars Topyhs

Tooltip Yiew top side in true colors

[JLoop

C1Gul

[ 0] 4 ] [ Cancel ]

Label Name of the button

Icon Path to icon

Script Path to the script (.vhs) file

Tooltip Info text when hovering over this button

Loop Activate if script must be looped until Abort button clicked
GUI Activate if script needs initial dialog

Edit Create/Edit initial dialog for current script (see 17.2)
OK Accept current button properties

Cancel Cancel the Button Properties Dialog

o To add a button, right click inside a Launch Pad section and select Add Button...
o To change button properties, right click the button and select Button Properties...
0 To delete a button, right click the button and select Delete Button

15.4 Convert an Editable to a Packaged Launch Pad

Editable Launch Pads are only for personal use. If there is a need to distribute them to
other users, the Editable Launch Pad needs to be converted into a Packaged Launch
Pad (.hst). A Packaged Launch Pad is in fact a Launch Pad archive with all its
referenced scripts & Icons inside.

The conversion can be done as follows:

1 Rightclick inside an Editable Launch Pad but outside a section

2 Select Save as Packaged Launch Pad...

To run the Packaged Launch Pad on another UcamX station:
1 Move the .hst file to the SHOME\VHS\LaunchPads directory
2 Add the Packaged Launch Pad to the HyperScript menu (see 21.3.3)
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16 Packaged Launch Pads

Packaged Launch Pads are Launch Pad archives containing all referenced scripts & icons.
They provide an easy way to transfer Launch Pads (including scripts and buttons) to other
computers running Ucam. Packaged Launch Pads can also be added to the HyperScript

menu using the VHS Menu editor (see xxx).

Packaged Launch Pads cannot be edited. If you need to change script or button properties
than you will need to convert the Packaged Launch Pad to an Editable version.

16.1 Create a Packaged Launch Pad

There is no way to build a Packaged Launch Pad from scratch. You need to create an

Editable Launch Pad and convert it into a Packaged one (see 15.4).

16.2 Convert a Packaged to an Editable Launch Pad

To run the Packaged Launch Pad on another UcamX station:

1 Move the .hst file to a SHOME\VHS\LaunchPads directory

2 Add the Packaged Launch Pad to the HyperScript menu (see 21.3.3)
3 Select the Packaged Launch Pad from the VHS Menu

To convert a Launch Pad from Packaged to Editable:
1 Right click inside a Packaged Launch Pad but outside a section
2 Select Convert to Editable Launch Pad...
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17 Script Startup Dialogs

When launching a script directly from the HyperScript menu or from an Editable Launch
Pad, it is also possible to start the script with an initial dialog. This dialog can be used to
retrieve all parameters needed to run the script. This way the script can run unattended

and does not have to be interrupted to request user input. The dialog with the run
parameters stays visible on the screen during the execution of the script.

@ Note: For an example of a Startup Dialog: see 22.3.2

17.1 Creating a Startup Dialog

A Startup Dialog can be defined on 2 locations:
o When Adding or Editing a menu item of type script
in the VHS Menu Editor (see 21.4.1)

o When Adding a Button or editing Button Properties
in an Editable Launch Pad (see 15.3.2)

"1 Visual HyperScript Menu Editor " Button Properties
Menu ltem Properties Button Properties
Tipe Sefipt id] Lahel Bottamn
Label Register [Tieon
Script imeWHES\Scripts\Registervhs Fﬁj
. Script jcriptsiTrue Colors Bottorm vhs
[ Loop ) e
Tooltip Show hottorm wiew in True Colors|
[1 startup Dialog (] Loop
[1 startup Dialog
’ QK ] [ Cancel ] ’ Ok ] ’ Cancel

17.2 Editing a Startup Dialog

Click the Edit button to see the Startup Dialog editor

" Visual HyperScript Menu Editor

E

Frompt ltems

Startup Dialog with all possible variable types (promptlabel)

Add...

Boolean (PromptBoolean)
Qption (PromptOption)
String (PromptString)
Integer (Promptinteger)
Double (PramptDouble)
Double Unit (PromptLinif)
Paint (PromptPoint)

taw (PromptLine)
%ctangle (FromptRectangle)
File Name (PromptFile)

[] Use Parameter Sets

Delete

Mave Up

Maove Diown

Freview.,.

OK

| [ Cancel

LS
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17.2.1 Buttons

Label Description
Add Add a new Startup Dialog item and specify its properties
Delete Delete the selected Startup Dialog item
Move Up Move the selected Startup Dialog item up
Move Down Move the selected Startup Dialog item down
Edit Edit the properties of the selected Startup Dialog item
Preview Preview the Startup Dialog
OK Accept the current Startup Dialog setup
Cancel Cancel the Startup Dialog Editor

@ Note: Options are grayed out if the corresponding action is not applicable

17.2.2 Add a Label
Click Add and select Type = Label

"4 Visual HyperScript Menu Editor
Frompt tem Froperdies
Type |Lahel v:

Label Thizis a GUIwith all possible variable t'g.fpes|

[ (8]:4 ” Cancel ]

17.2.3 Add a Boolean
Click Add and select Type = Boolean

i Uy

"4 Visual HyperScript Menu Editor
Frompt tem Properdies

Type Baoolean V
Label Boolean

Variable Mame m-fari
Diefault Yalue

[ Ok ] ’ Cancel

Check Default Value box if default value is “true”
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17.2.4 Add an Option List
Click Add and select Type = Option

-~

"4 Visual HyperScript Menu Editor

~Prompt ltem Froperies

Type |Optiun

Lahel CQptian
Yariahle Mame DVari

Default Yalue

Dption Walues |5

m

’ (8] 4 ] [ Cancel

17.2.5 Add a String
Click Add and select Type = String

-~

" Visual HyperScript Menu Editor

~Prompt ltem Froperies

Type | String

Lahel String
Yariable Mame 55tring|

Defaultalue |abc

’ (8].4 ” Cancel

17.2.6 Add an Integer
Click Add and select Type = Integer

Visual HyperScript User Manual

45




17.2.7

17.2.8

17.2.9

L 1

" Visual HyperScript Menu Editor

~Prompt ltem Froperies
Type |Integer M

Lahel Integer

Yariahle Mame Nar{

DefaultValue (123

[ (8] 4 ” Cancel

Add a Double
Click Add and select Type = Double

"4 Visual HyperScript Menu Editor

~Prompt tem Properdies
Type |D|:|uble &]
Lahel Douhble

Variable Mame d\-fari

DefaultYalue |123.456

[ Ok ] ’ Cancel

Add a Unit Value
Click Add and select Type = Unit Value

-~

" Visual HyperScript Menu Editor

~Prompt ltem Froperies

Type |UniWaIue

Label Double Linit
Yariahle Mame u\-fari

DefaultYalue |[123.4456

’ (8] 4 ” Cancel

Add a Point
Click Add and select Type = Point
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-~

" Visual HyperScript Menu Editor

~Prompt ltem Froperies

Type |F'|:|int

Lahel Faint
Yariable Mame p\-fari

DefaultYalues X 100 1 140

’ (8].4 ” Cancel

17.2.10 Add aline
Click Add and select Type = Line

"4 Visual HyperScript Menu Editor

~Prompt tem Properdies

Type |Line

Label Ciramy
Variable MName ILine|
DefaultVYalues X1 0 1|0

#2100 Y2240

’ (8] 4 ] [ Cancel

17.2.11 Add a Rectangle
Click Add and select Type = Rectangle

"4 Visual HyperScript Menu Editor

~Prompt ltem Froperdies

Type 'Rectangle

Lahel Rectangle
Yariahle Mame chﬂ

DefaultYalues Xmin |-50 Yrmin |-50

Hmax 1480 Ymax | 300

’ (8].4 ” Cancel

17.2.12 Add a File Name
Click Add and select Type = File Name
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-

"4 Visual HyperScript Menu Editor

~Prompt tem Properdies

Type |Fi|e MHarme

Lahel File Mame
Variable Mame Nar{

DefaultYalue |Dobyvdohs

[ Ok ] ’ Cancel

17.2.13 Preview

Click Preview to see the completed Startup Dialog

-

'Eg Malog Preview

This is a Startup Dialog with all possible variable types

Eoolean
Option  |E
String ahc
Inteder 123

Double 123.456

Double Unit |123.456

Faint Es 100
DCirawy 1 0
a2 100

Rectangle  Xmin |-50
Hmax 1450

File Mame | Doblylobs

' 140

1 0

2 240

Ymin |-50

Ymax | 300

Fick

Cran

Ciran

s £ e
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18 Customizing VHS Functions

The Visual HyperScript API Specification lists all available VHS commands. Most of the
UcamX functionality is already included. If you need more functionality, than you will need

to do some customization.

18.1

Write custom commands

Why?
o Functionality — to add custom functions
0 Localization — to translate commands into your own language

@ Example: for a new command that reads a text file and prints each line
to the console we could use the following code:

// This program reads a text file and prints each line to the
console.
// It uses FileOutputStream to read the file.
public void filelInput (String sFileName) {
File file = new File (sFileName) ;
FileInputStream fis = null;
BufferedInputStream bis = null;
DataInputStream dis = null;

try {
fis = new FileInputStream(file);
// BufferedInputStream is added for fast reading
bis = new BufferedInputStream(fis);
dis = new DatalnputStream(bis);
// dis.available() returns 0 if the file has no more lines
while (dis.available() !'= 0) {

// reads the line from the file and prints it to the console

System.out.println(dis.readLine());

}

// dispose all the resources after using them
fis.close () ;
bis.close () ;
dis.close();

} catch (FileNotFoundException e) {
e.printStackTrace();

} catch (IOException e) {
e.printStackTrace () ;

}
Save this code as filelnput.vhs in your init directory and restart UcamX.

Run the new command as filelnput(<path to a file>).

@ Tip: VHS contains a number of Operating System commands that can be
used to handle files. All Operating System commands start with “os”.
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18.2 Modify existing commands

Why?

o Functionality — to create modified versions of functions

o Add/remove Parameters — to add custom or remove obsolete parameters
o Customize parameters — to preset parameters with custom values

18.3 Include and/or combine existing commands

Commands can be included and/or combined into new functions which are not yet
available,
e.g. to implement a percentual scale command we could combine

o scale(val) - scales object dimensions and coordinates

a distort(Xval,Yval) - scales coordinates without changing object dimensions

into a usr_scale_pct(n) command that would apply a percentual scale of n% to
(selected) objects without affecting the coordinates.

/**
* Percentual scale of selected apertures
* @param Ipct Percentual scale value
*/
void usr_scale_pct(double Ipct) {
double Dpct = Ipct / 100.0;
scale (Dpct, false); // This is a VHS command
double Ddistort = 1.0 / Dpct;
distort(Ddistort, Ddistort); // This is a VHS command

Save this code as usr_scale_pct.vhs in your init scripts directory.

@ Note: The demo chapter shows how to do a percentual scale using prompt
commands (see 22.6.1) or using a custom function (see 22.6.2).

18.4 Load custom commands into UcamX

Custom commands are loaded at startup of UcamX. The vhs.init.scripts ucam.db
key is used to indicate the location of your custom commands. e.g set vhs.init.scripts
to HOME:/VHS/init to have all command files (.vhs) in the scripts folder available in

UcamX.
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19 Integration of VHS Scripts in UcamX

A VHS script can be executed in 7 ways:

Easy
a From the VHS Editor

a From the HyperScript Menu

a From an Editable VHS Launch Pad

o From a packaged VHS Launch Pad
Advanced

a From any other UcamX Menu
o From a Toolbar

0 As a Startup Script

o As a Standalone Script

19.1 Executing a Script from the VHS Editor

As long as a script is under development it will be launched from the VHS Editor.
As soon as a script is ready, it will be launched using 1 of the 7 other methods.

1 Open the VHS Editor
2 Open a script (.vhs)
3 Click the “Run” button

19.2 Executing a Script from the HyperScript Menu

This is the preferred way of launching your scripts.

1 Open the VHS Editor

2 Open a script (.vhs)

3 Click the "Add HyperScript Menu Item” button
4  Enter the Menu Item name

5 Click OK

The script can now be launched from the HyperScript menu.

19.3 Executing a Script from an Editable Launch Pad

A Launch Pad is a dockable dialog containing user defined buttons.
Each button invokes a vhs script.

1 Add an Editable Launch Pad to the HyperScript menu (see 21.3.2)
2 Add a button, linking to a script to the Editable Launch Pad (see 15.3.2)

The Launchpad is called using its menu option in the HyperScript menu

The script is launched using the button on the Launch Pad.
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19.4 Executing a Script from a Packaged Launch Pad

1 Add a Packaged Launch Pad (.hst) to the HyperScript menu (see 21.3.3)

All scripts included in the Pakaged Launch Pad can now be launched from the buttons
on the packaged Launch Pad in the HyperScript menu.

@ Note: If you want to edit any of the Packaged Launch Pad objects than you
need to convert the Packaged Launch Pad to an Editable Launch Pad.
You can do this by right clicking the Launch Pad and selecting the
Convert to Editable Launch Pad option. The <launch pad name>.hst file
will be replaced by a folder <launch pad name> containing all editable
scripts (.vhs)

19.5 Executing a Script from any other UcamX Menu

Use the Toolbar Manager to:
1 Add the script as a new source command
2 Assign the new source command to an existing menu

A detailed procedure can be found in the UcamX User Interface Guide
(chapters 8.8 to 8.11)

19.6 Executing a Script from a Toolbar

Use the Toolbar Manager to:
1 Add the script as a new source command
2 Add the new source command to an existing toolbar

A detailed procedure can be found in the UcamX User Interface Guide
(chapters 8.8 and 8.2)

19.7 Executing a Script as a Startup Script

A script can be used to perform some initialization tasks. A fast way to
implement this is to change the target field of the UcamX startup icon:

1 Right-click the UcamX startup icon

2  Select Properties from the context menu
The target field contains something like:
C:\Ucamco\UcamX2016\bin\ucamXLauncher.bat

3 Add —vhs ‘quoted script path’ to the Target field
e.g. C:\Ucamco\UcamX2016\bin\ucamXLauncher.bat -vhs:
“D:\HyperScript\Scripts\MyScript.vhs”

4 Click OK

5 Double click the UcamX startup icon to see how UcamX is started and
MyScript.vhs is executed
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19.8 Executing a Script as a Standalone Application

Scripts can also be used as a Standalone applications. They can make use of all
UcamX functionality without even starting the UcamX main window.

A special batch file VHSExecuter.bat takes care of this.
By default it is located in the ...\UcamX2016\bin directory.
Make sure that your Path environment Variable includes a path to this executable.

1 Click Start > Run

2 Enter ‘cmd’ and press enter
A DOS window with command prompt appears

3 Enter VHSExecuter’ ‘quoted script path® ‘parameters’ and press enter
€.9. VHSExecuter.bat “D:\scripts\JobInfo.vhs” \"Multi\”

@ Note: string parameters must be enclosed by \’

@ Tip: The Demo chapter contains an example of a Standalone script (see 22.11)
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20 Visual HyperScript Editor

20.1

20.2

Introduction

The Visual HyperScript Editor is a user friendly environment for recording,
editing and debugging VHS scripts.

promptStart ("","Welcome"); // Dialog name "Welcome"
promptLabel ("Welcome to HyperScript");
promptLabel ("The easy solution to automate UcamX");
promptEnd () ;

Example script displaying a Welcome message

VHS Editor Dialog

The VHS Editor is launched from the HyperScript menu.

"HVHS Editor =JoJEd

File Edit Launch Record ‘Window Help

& ELE R 30

- =
Untitled_0.vhs *True Colars Top.vhs B2 |
1// VHS demo script A

2/ Display top lavers using true colors
ZhideAll (] ;

dactivate ("all", "", false):
SgetInPlane (1, "layer™, "outer™, "top®™, 11:
tgetInPlane (2, "extra™, "mask"™, "top™, 11:
7setInPlane (3, "drill™, ", "ro 1y

SszetInPlane (4, "extra™, Moucline®™, ", 1):
SsetInPlane (5, "extra™, "=ilk"™, "cop®™, 1):
10viewZoomTotal () : |
El consale 53 | 29= variables OptionPane ® aH | - =0
Ucan's message window
-
=

The VHS Editor Dialog consists of:
a Menu Bar

o Button Bar

0 Editor Area with Tabbed Panels
a Option Panel
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20.2.1 Menu Bar
File Menu
Menu Option Description Icon on Button
Bar or shortcut
New File Create a new script file (.VHS)
A new tab page is added
Open File Open an existing script file ((VHS) =
Close Close the current tab page CTRL+W
Close All Close all tab pages CTRL+SHIFT+W
Save Save script in default script directory =]
Save As ... Save script using File Selection Dialog =]
Save All Save all scripts in current location ]
Add HyperScript Adds a link to the current script to the LEl
Menu Item HyperScript Menu
Exit Exit VHS Editor
Edit Menu
Menu Option Description Icon on
Button Bar
Undo Undo last action &
Redo Redo last action >
Find/Replace Find/Replace string in script
Launch Menu
Menu Option Description Icon on
Button Bar
Debug Start debugger %
Run Run script Q
Step Run next step b
Step Into Step into =
Run to Line Run to line with cursor M
Suspend Hold execution il
Resume Stop debugger I»
Terminate Stop execution [
Record Menu
Menu Option Description Icon on
Button Bar
Start Recording | Start script recording @
Stop Recording Stop script recording ]
Visual HyperScript User Manual 55




Window Menu

Icon | Menu Description Shortcut
Option
Console | Displays script execution feedback Ctrl+Alt+C
Output of print() commands is shown here
= Variables | Displays the value of customer defined Variables | Ctrl+Alt+V
and pre-defined Variables (CurrentLay, CurrentApe
and CurrentOpbject) during debugging of a script
Option- Displays selectable record options Ctrl+Alt+O
Panel
Help Menu
Icon | Menu Option Description Shortcut
VHS Editor Help Shows Help page with direct link to
VHS User Manual
VHS API Reference | Shows Help page with direct link to
VHS API Specification
About VHS Editor Shows VHS Editor version
information and installation details
20.2.2 Button Bar
Buttons
Icon | Description
Open new empty script (.vhs)
= | Open existing script
Izl | Save current script
LEl | Add HyperScript Menu Item
Drop down list of single line commands (see 14.3)
& | Start Recording
[E | Stop Recording
%r | Start debugger
2 | Run script
P | Run next step
= | Stepinto
M | Run to line with cursor
il Hold execution
I | Stop debugger
Stop execution
Show Option Panel
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20.2.3 Editor Area with Tab Pages

The Editor Area holds one tab page for each open script. Scripts are made current
by clicking on the title in the tab.

Buttons

Icon | Description

z | Show list of other (2) tab pages

= Minimize VHS Editor area

| Maximize VHS Editor area

= Restore previous VHS Editor view (when minimized)

| | Show Editor area (when minimized)

20.2.4 Option Panel

The Option Panel allows the user to select/deselect recording options.
All options can also be set using ucam.db keys

OptionPanel 3 =g

ltem Value

Hide Info Dialog

& O

Record Layer Activate

|

Record copy/move as doCopy/doMove

&l

Record Not Implemented

]

Record Open Dialog

&l

Record setMode

&l

Show Line Mumbers

Show Variable Type

0o

Stop recording when script is saved
Record mode Coordinates Xy ~

Record mode setlnPlane class ~

Recording options - with corresponding ucam.db keys
Hide Info Dialog - vhs.options.hide_info_Dialog
Hide Information Dialog for pick & drag commands
Default: false
Record Layer Activate - vhs.options.record_layer_activate
Set active to record individual activation of layers via checkbox
Default: true

@ Note: The Activation using “Activate” menu is always recorded
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Record copy/move as doCopy/doMove -
vhs.options.record_copymove_as_doCopydoMove

Set active to record copy and move actions as doCopy or doMove
Default: false

Record Not Implemented - vhs.options.record_not_implemented
Activate to mark non implemented commands
Default: true

Record Open Dialog - vhs.options.record_open_Dialog
Set active to record opening and closing of UcamX Dialogs
Default: true

Record setMode - vhs.options_record_setmode
Always start recording with a setMode command
Default: true

Show Line Numbers - vhs.options.show_line_numbers
Show line numbers in front of code (needed for debugging)
Default: true

Show Variable Type — vhs.options.show_Variable type
Show type of Variables in Variables View during debugging
Default: false

Record mode Coordinates - vhs.options. record _mode coordinates

Choose how coordinates are recorded

Q X,y - using coordinates

O object - using point, line and rectangle commands

O pick - using dragPoint, dragLine and dragRectangle commands
Default: object

Record mode setIinPlane — vhs.options.record_mode_ setinplane

Choose how setinPlane is recorded

o class - plane, class, attach and index

O subclass - plane, class, subclass, attach and index
O index - plane and index

0 name — plane and name

Default: class
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20.2.5 Variables

The Variables window shows the current value of all pre-defined and customer defined
Variables during debugging

"M YHS Editor =Jo&d

File Edit Launch Record ‘Window Help

=gEir- ] i b= Mo
*Intitled_0.vhs Variables whs &3 =0
1// WHS demo script N
2// Dialog showing all poassible wvariable types I
GBooleanlef = true;

40ptionshef = [{"L", "E"}]:

EStringDhef = Mabot:

tInthef = 123;

Thoublelef = 123.456;

SaFileNamelbef = dbPath("vhs.howe") + ™yhscriptsh\Variables.vha";
SDoubleUnitDhef = 123.456; // current unit used

10promptStart () :l |
] 2
& console | 4= variables 53 =0
Mame Yalue
CurrentLay laver layverl
Currentape 207 =CIR,1
Currentdbject nat available
BooleanDef true
Doublebef 123,456
DoubleUnitDef 123,456
InkDef 123
OptionsDef [{"a", "E"}]
StringDef "abc"
sFileMarneDef "D iUcannihomel1YHSDermol \scripts. .
Debugging. ..

20.2.6 Console

The console window shows all feedback of the running script,
The results of your Print commands are also displayed in this window.
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21 Visual HyperScript Menu Editor

21.1 Introduction

The Visual HyperScript Menu Editor is launched from the Hyperscript menu and
allows you to add VHS Scripts and Launch Pads to the HyperScript menu.

-

"4 Visual HyperScript Menu Editor
Menu ltems

Demo Launch Pad Add..

Register Script Delete

Edit...
Ok ] [ Cancel ]
21.2 Buttons
Add Add a new menu item and specify its properties (see 21.3)
Delete Delete the selected menu item
Move Up Move the selected menu item up
Move Down Move the selected menu item down
Edit Edit the properties of the selected menu item see (see 21.4)
OK Accept the current menu setup
Cancel Cancel the Menu Editor

@ Note: Options are grayed out if the corresponding action is not applicable

21.3 Add menu ltem

The Add button of the VHS Menu Editor can add:
a Scripts
o Editable Launch Pads
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o Packaged Launch Pads (.hst)
o Separators

21.3.1 Add a Script to the HyperScript Menu
Click ADD... and set Type to Script

f & Visual HyperScript Menu Editor W
Menu ltem Froperies
Type Script V
Label Renister Job
Script WicarmhometWHS\scripts\Register vhs
[1Laop
CJeu
[ Ol ] [ Cancel
Label Menu item text
Script Path to the script (.vhs) file
Loop Activate if script must be looped until Abort button clicked
GUI Activate if script needs initial dialog
Edit Create/Edit initial dialog for current script (see 17.2)
OK Accept current menu item properties
Cancel Cancel the Menu Editor

@ Note: Scripts can also be added to the HyperScript menu
using the addHyperScriptMenultem command

21.3.2 Add an Editable Launch Pad to the HyperScript Menu
Click ADD... and set Type to Editable Launch Pad

"5 Visual HyperScript Menu Editor
Menu ltem Froperties
Type | Editable Launch Pad v

Label True Colors Launch F'ad|

]2 ] [ Cancel ]
Label Menu item text
OK Accept current menu item properties
Cancel Cancel the Menu Editor
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@ Note: The resulting Editable Launch Pad is empty. Chapter 15.3 explains
how to add Pages, Sections and Buttons to this Launch Pad

21.3.3 Add a Packaged Launch Pad to the HyperScript Menu
Click ADD... and set Type to Packaged Launch Pad

f % Visual HyperScript Menu Editor -\
Menu ltem Froperties
Type Packaged Launch Pad (hstfile) Bl
Label Company Laoga Launch Pad

Launch Pad mihomeWHS\WLaunchPadsilogo hst @

Ol ] [ Cancel ]
Label Menu item text
Launch Pad Path to the Packaged Launch Pad (.hst) file
OK Accept current menu item properties
Cancel Cancel the Menu Editor

@ Note: A Packaged Launch Pad (.hst) is an archive containing a dialog with all its
scripts.This concept makes it possible to exchange Launch Pads with other
UcamX users.

21.3.4 Add a Separator to the HyperScript Menu
Click ADD... and set Type to Separator

"4 Visual HyperScript Menu Editor
mMenu lterm Properies
Type | Separator Bl
]9 ] [ Cancel
OK Accept current menu item properties
Cancel Cancel the Menu Editor

@ Note: Separators are used to divide the HyperScript menu
into multiple sections e.g. scripts and launch pads.

21.4 Edit HyperScript menu Items

The Edit button of the VHS Menu Editor edits the properties of:
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21.4.1

o Scripts
o Editable Launch Pads
o Packaged Launch Pads (.hst)

Edit Script Properties

Select a script in the Menu Items list and click Edit...

-

"4 Visual HyperScript Menu Editor w

henu lterm Properties

Label RegisterJub|

Script WioarmhomelWHSscripts\Redister vhs

[ ]Loog

] Gul

[ ]9 ] ’ Cancel

Label Name of the selected script

Script Path to the script (.vhs) file

Loop Activate if script must be looped until Abort button clicked
GUI Activate if script needs Startup Dialog

Edit Create/Edit initial dialog for current script (see 17.2)
OK Accept current menu item properties

Cancel Cancel the Menu Editor

21.4.2 Edit Editable Launch Pad Properties

Select an Editable Launch Pad in the Menu Item list and click Edit...

-

"5 Visual HyperScript Menu Editor

Menu tem Properies

Label True Colors Launch F'ad|

Ok ” Cancel ]

Label Name of the Editable Launch Pad
OK Accept current menu item properties
Cancel Cancel the Menu Editor
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21.4.3 Edit Packaged Launch Pad Properties

Click Edit... and select a Packaged Launch Pad in the Menu Item list

-~

"5 Visual HyperScript Menu Editor

Menu ltem Froperties

Label Company Logo Launch F'ad|
Launch Pad | mihometYHSILaunchPadsilogo hst

0] 4 ] [ Cancel ]
Label Name of the Packaged Launch Pad
Launch Pad Path to the Packaged Launch Pad (.hst) file
OK Accept current menu item properties
Cancel Cancel the Menu Editor
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22 Running the Demo scripts

You can download a number of basic and advanced demo scripts that can be started from
the Demo Launch Pad in the HyperScript menu.

Run the scripts to get a first impression of Visual HyperScript. Open each script in the VHS
Editor and examine the code to find out how a simple recorded script can be enhanced to
fit your personal needs.

22.1 Initial Actions

1
2
3

62

7
8
9

Make a backup of your current scripts and Launch Pads.

Download the VHSDemo.zip archive from the Ucamco download page
Extract the VHSDemao.zip archive inside your HOME directory

Your HOME directory should look like this:

- OEE
+ | YHS
= |3 YHaDema
) BakchFiles
) DPF
] icons
) init
+ ) Jobs
+ ) LaunchPads

) Scripks
+ () workspace

Set the ucam.db key vhs.home to the new HOME:/VHSDemo folder
Restart UcamX

Use the VHS Menu Editor to add the Demo Packaged Launch Pad
to the HyperScript menu

i Visual HyperScript Menu Editor
Menu ltem Properies

Type Packaged Launch Pad (hstfile) A4
Label Dema Lauch Pad

Launch Pad DialcarmihometvHSDemollaunchPads\Demo Launch Pad hst

[ Ok H Cancel ]

Start the Demo Launch Pad from the HyperScript menu
Scale the Demo Launch Pad to full size
Drag and dock in to a location on the screen where is can stay

10 Save the Workspave as “VHS Demo”
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@ Note: Some interactive scripts from the Demo Launch Pad use a dialog window
to show/enter info. The Registration Script (see 22.3 steps 3 to 5) explains
how to fix the location of this dialog on your screen.

22.2 Welcome

This script creates a job in your temporary storage directory (set your TEMP
environment Variable if it is not yet available), creates a layer and flashes a
welcome message using a text aperture.

Actions
1 Load the “VHS Demo” Workspace
2 Click the Show button in the Welcome section of the Demo Launch Pad

Script name: “Welcome.vhs”

// VHS demo script
// Creates a job and uses a text aperture to flash a welcome text

//

// Create a job in your temp directory

Stemp = envString ("TEMP"); // get location of temp storage
newJob (Stemp + "VHSDemo\\Jobs\\Welcome", "Welcome");

//

// Create a layer

createExtra ("top");

//

// Create a text aperture with the welcome message
apeCreateText (3, 5.0, "Welcome to Visual HyperScript");
//

// Insert one Flash using the text aperture
insertFlash (Point (0.0, 0.0), 0, "select");

//

// Zoom

viewZoom ("total");

22.3 Registration

22.3.1 Recorded

The Register script is a simple recorded script that registers all copper layers of a
job to the drill layer
Actions

1 Open the Register job from HOME:/VHSDemo/Jobs/Register
Note how top mask, drill and silk screen are not registered to the copper layers

2 Load the “VHS Demo” Workspace

3 Click the Recorded button in the Registration section of the Demo Launch Pad
The layers will be registered

;- Note: The top silk layer can not register because it does not contain flashes
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22.3.2

Script name: “Register.vhs”

// VHS demo script

// This ia a recorded script

//

setMode ("selall"”, "mm", "no");

// Register Top Copper to Drill
hideAll () ;

activate ("all", "", false);
setInPlane (1, "layer", null, "", 1);
setInPlane (3, "drill", null, "", 1);
activate ("drill", null, 1, true);
registerlayers () ;

viewZoomTotal () ;

// Register Top Mask to Top Copper
hideAll () ;
setInPlane (1,
setInPlane (3,
activate ("layer", null, 1,
registerlayers () ;

// Register Bottom Copper and Inners to Drill

"extra", null, "", 2);
"layer", null, "", 1);
true) ;

hideAll () ;

activate ("all", "", false);
setInPlane (1, "layer", null, "", 6);
setInPlane (4, "layer", null, "", 5);
setInPlane (4, "layer", null, "", 4);
setInPlane (4, "layer", null, "", 3);
setInPlane (4, "layer", null, "", 2);
activate ("layer", null, 2, true);
activate ("layer", null, 3, true);
activate ("layer", null, 4, true);
activate("layer", null, 5, true);

setInPlane (3, "drill", null, "", 1);
activate ("drill", null, 1, true);
registerLayers () ;

// Register Bottom Mask to Bottom Copper

hideAll () ;

activate ("all", "", false);
setInPlane(l, "extra", null, "", 4);
setInPlane (3, "layer", null, "", 6);

activate("layer", null, 6, true);
registerlayers () ;

// Show result

hideAll () ;

activate ("all", "", false);
setInPlane(l, "layer", null, "", 1);
setInPlane (2, "extra", null, "", 2);

setInPlane (3, "drill", null, "", 1);
viewZoomTotal () ;

With Startup Dialog

The “Register with Startup Dialog” script adds a Startup Dialog to allow the operator to
select the registration steps.

Actions

1 Open the Multi job from HOME:/VHSDemo/Jobs/Register

2 Load the “VHS Demo” Workspace
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3 Click the With Startup Dialog button in the Registration section
of the Demo Launch Pad

"4 Register With GULvhs
Register Top Copper to Drill ]
Register Top Maskto Top Copper Il

Reqister Eottomn Copper and Inners ta Drill []
Register Eottom Maskto Bottom Copper [

@ Note: This startup dialog was created when the With Startup Dialog button
was added to the Launch Pad. The GUI toggle was activated and 4
Booleans (bSelect 1 to 4) were added (see 15.3.3 and 17.2.3)

4  Move the dialog to a location on the screen where is can stay

5 Use Workspaces > Save to store the location and size of the registration dialog
in the VHS Demo workspace
6 Activate one or more registration entries

7 Click OK
Repeat steps 6 and 7 until the registration process is completed.

@ Note: As long as the dialog stays on the screen you could open other jobs
with a similar layer structure and perform the registration

Script name: “Register with Startup Dialog.vhs”

// VHS demo script

// Recorded Register script, completed with

// comments, Variables, decisions and print commands

// Parameters (bSelect 1 to 4) are set in the Startup Dialog

//

setMode ("selall", "mm", "no");

hideAll () ;

activate ("all", "", false);

//

if (bSelectl == true) {
print (" 1. Register top copper to drill");
setInPlane (1, "layer", null, "", 1);

setInPlane (3, "drill", null, "", 1);
activate ("drill", null, 1, true);
registerlayers () ;

}

if (bSelect2 == true) {
print (" 2. Register top mask to top copper"):;
setInPlane(l, "extra", null, "", 2);

setInPlane (3, "layer", null, "", 1);
activate ("layer", null, 1, true);
registerLayers () ;
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22.3.3

if (bSelect3 == true) {
print (" 3. Register bottom copper and inners to drill");
setInPlane (1, "layer", null, "", 6);
setInPlane (4, "layer", null, "", 5
setInPlane (4, "layer", null, "", 4
setInPlane (4, "layer", null, "", 3
setInPlane (4, "layer", null, "", 2
activate ("layer", null, 2, true)
activate ("layer", null, 3, true);
)
)

’

activate ("layer", null, 4, true
activate ("layer", null, 5, true
setInPlane (3, "drill", null, "", 1);
activate ("drill", null, 1, true);
registerlayers () ;

}

’

if (bSelectd4 == true) ({
print (" 4. Register bottom mask to bottom copper"):;
hideAll () ;
activate ("all", "", false);
setInPlane(l, "extra", null, "", 4);
setInPlane (3, "layer", null, "", 6);

activate ("layer", null, 6, true);
registerlayers () ;
}
// Display registered layers
setInPlane (1, "layer", null, "", 1);
setInPlane (2, "extra", null, "", 2);
setInPlane (3, "drill", null, "", 1);
setInPlane (5, "extra", null, "", 1);

viewZoomTotal () ;

//

@ Note: The “print” command is a BeanShell command and therefore
has no color coding

Using external script

The “Register with runFile” script uses a simple dialog to request the jobname.
The registration is done by including a call to the Register.vhs script

Actions

1 Load the “VHS Demo” Workspace

2 Click the With runFile button in the Demo Launch Pad

"5 Visual HyperScript Prompt

Joh Registration
Joh: |

[ Continue ” Ahort ]

3  Select the Multi job in your HOME/VHSDemo/Jobs/Register directory
4  Click Continue
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Script name: “Register with runFile.vhs”

// VHS Demo script
// Interactive registration script using the Register.vhs script
promptStart () ;
promptLabel ("Job Registration");
SjobName = promptFileName ("Job: ", "");
promptEnd () ;
opendJdob (SjobName) ;
sVHSHome = dbPath ("vhs.home") ;
runFile (sVHSHome + "\\Scripts\\Register.vhs"); // call external script
print ("Job "+ SjobName + " registered");

22.4 Insert Ucamco Logo

The insert logo script loads a pre defined Ucamco logo in dpf format into the
aperture list of the layer in plane 1 (red) and flashes it at coordinates 0,0.

It is up to the operator to move the logo to a suitable place on the layer.
There is a positive and a reverse version of the logo.

Actions

1 Open ajob (e.g. HOME:/VHSDemo/Jobs/Multi/Multi.job)

2 Load the “VHS Demo” Workspace

3 Display only the top layer in plane 1 (red)

4  Click the Positive button in the Insert Logo section of the Demo Launch Pad

Script name: “Insert Ucamco Logo.vhs”

// VHS demo script

// This script loads a logo and flashes it at the clicked location
sVHSHome = dbPath("vhs.home");// get ucam.db key

loadApertures (sVHSHome + "\\DPF\\Ucamco.dpf");

pVar = pickPoint("Click on a point"); //Get Point coordinates
insertFlash (pVar, 0, "select");
viewZoom ("total");

22.5 Rename Layers

This script renames all layer names of an imported customer job to company standard
names (e.g. jobnumber_layerinfo). The console window shows a log of all renamed
layers.

Actions

1 Open the multi job from HOME:/VHSDemo/Jobs/Rename

2 Load the “VHS Demo” Workspace

3 Click the Do It button in the Rename Layers section of the Demo Launch Pad
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" Visual HyperScript Prompt

Joh Mumber |

[ Continue ][ Ahort l

4  Enter a job number (can be a mix of numbers and characters)
5 Click Continue

Script name: “Rename Layers.vhs”

// VHS demo script
// Rename layers to company standard naming
print ("Rename Layers");
promptStart () ;

JobNumber = promptString("Job Number",
promptEnd () ;
// Dedicated loop to count the number of signal layers
iSignalCount = 0;
forEachSignal () ; {

iSignalCount++;

llll);

}
// Rename signal layers
forEachSignal () {
if (layIndex() == 1) {
print ("Rename " + layName() + " to " + JobNumber +

" Copper");
setInPlane (1, "layer", null, "", layIndex(), true);
modifyLayer (JobNumber +
" Copper","","layer",laySubClass (), layIndex (), false, 0.0, layReadable(),
"",O'O);
}
else if (layIndex() == iSignalCount) {
print ("Rename " + layName() + " to " + JobNumber + " Solder");
setInPlane (1, "layer", null, "", layIndex(), true);
modifyLayer (JobNumber +
" Solder","","layer",laySubClass (), layIndex (), false, 0.0, layReadable(),
""" o0.0);
}
else {
print ("Rename " + layName() + " to " + JobNumber + " L" +
layIndex());
setInPlane(l, "layer", null, "", layIndex (), true);
modifyLayer (JobNumber + " L" +
layIndex(),"","layer", laySubClass (), layIndex (), false, 0.0, layReadable ()
;" 0.0)

}
}

// Rename extra layers

forEachExtra () {
print ("Rename " + layName() + " to " + JobNumber + " " +
laySubClass () + " " + layAttach());
setInPlane (1, "extra", null, "", layIndex(), true);
modifyExtra (JobNumber + " " + laySubClass() + " " +
layAttach(), "", "extra", laySubClass(), layAttach(), layIndex(),
false, "");

}
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// Rename drill layers
forEachDrill () {
print ("Rename " + layName() + " to " + JobNumber + " " +
laySubClass()) ;
setInPlane(l, "drill", null, "", layIndex(), true);
modifyDrill (JobNumber + " " + laySubClass(), "", "drill",
laySubClass (), layFrom(), layTo(), 0.0);
}

22.6 Percentual Scaling of Objects

22.6.1 Using an Interactive Script
The percentual scale function combines the UcamX scale and distort functions into a
new interactive function.
1 Actions

Open any job

Load the “VHS Demo” Workspace

Select a flashed object

Click the Interactive button in the Percentual Scale section of the Demo Launch
Pad

g b~ wWwDN

"5 Visual HyperScript Prompt

Enter a percentual scale value IZI|

12810 scale upwith 29%

7510 scale down with 25%

Click Continue to scale the current selection

[ Continue ][ Ahart

6 Enter a scale value
7 Click Continue

Script name: “scale_pct.vhs”

// VHS demo script
// Percentual scale script using scale and distort functions
promptStart () ;
Ipct = promptInteger ("Enter a percentual scale value", 0);
promptLabel ("125 to scale up with 25%");
promptLabel ("75 to scale down with 25%");
promptLabel ("Click Continue to scale the current selection");
promptEnd () ;
double Dpct = Ipct / 100.0; // java calculation
scale (Dpct, false);
double Ddistort = 1.0 / Dpct; // java calculation
distort (Ddistort, Ddistort);

;- Note:This script uses pure java instructions to perform the calculations.
Variables in pure java instructions need to be typed.
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22.6.2

22.7

Using a Custom Function

If we always want to scale the selected apertures with a fixed value, than we could
replace the script by a custom command. Custom commands are placed in a
directory set by the vhs.init.scripts ucam.db key. For this demo we are setting its
value to HOME/VHSDemol/init

The init directory already has the following usr_scale_pct.vhs script

/**
* Percentual scale of selected apertures
*

* (@param iPct Percentual scale value

*/

void usr scale pct (double iPct) {
double dPct = iPct / 100.0;
System.out.println ("Scale = " + dPct);
scale (dpPct, false);
double dDistort = 1.0 / dPct;
System.out.println ("Distort = " + dDistort);
distort (dDistort, dDistort);

}
Now we can use the use the usr_scale_pct command in our scripts.

Actions

1 Open any job

2 Select a flashed object

3 Load the “VHS Demo” Workspace

4  Click the Custom button in the Percentual Scale section of the Demo Launch Pad

Script name: “scale_pct Custom.vhs”

// VHS demo script

// Percentual scale script using custom function
usr_scale pct(125);

print ("All selected apertures are scaled by 125%");

;_ Note: Custom commands have no color coding

Set Top/Bottom View to True Colors

This script shows the top and bottom side of a printed circuit in “True Colors”.

To show true colors, you will need:
o A job with an outline layer using a contour aperture
a A special ucamcolor.db file

Actions

1 Make a backup of the ucamcolor.db file in the HOME directory (if existing)
2 Copy the True Colors ucamcolor.db file to your HOME directory

3 Open the multi job from HOME:/VHSDemo/Jobs/Multi final
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4  Load the “VHS Demo” Workspace

5 Click the Top View button in the True Colors section of the Demo Launch Pad
to see a top view of the printed circuit board in true colors

6 Click the Bottom View button in the True Colors section of the Demo Launch Pad
to see the bottom view of the printed circuit board in true colors

Script name: “True Colors Top.vhs”

// VHS demo script

// Displays the top side of a pcb job in realistic colors
hideAll () ;

activate ("all", "", false);

setInPlane (1, "layer", "outer", "top", 1);

setInPlane (2, "extra", "mask", "top", 1);
setInPlane (3, "drill"™, "", "", 1);
setInPlane (4, "extra", "outline", "", 1);
setInPlane (5, "extra", "silk", "top", 1);
viewZoomTotal () ;

@ Note: The recording of this script was done with
Record mode setIinPlane = subclass

Script name: “True Colors Bottom.vhs”

// VHS demo script

// Displays the bottom side of a pcb job in realistic colors

hideAll () ;

activate ("all", "", false);

iSignalCount = 0;

forEachSignal () ; {
iSignalCount++;

}

setInPlane (1, "layer", "outer", "bottom", iSignalCount);
setInPlane (2, "extra", "mask", "bottom", 1);
setInPlane (3, "dri1l1l"™, "", "", 1);

setInPlane (4, "extra", "outline", "", 1);

setInPlane (5, "extra", "silk", "bottom", 1);
viewZoomTotal () ;

@ Note: a loop was added to count the number of copper layers

22.8 Drill Map with Dimensions

This script creates a new drill map with outline and adds dimensioning info.

Actions
1 Open the multi job from HOME:/VHSDemo/Jobs/Multi final
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22.9

2 Load the “VHS Demo” Workspace

3 Click the Create button in the Drill Map with Dimensions section
of the Demo Launch Pad

Script name: “Drill Map with Dimensions.vhs”

// VHS demo script

// This script creates a new drill map with outline and dimensions
setMode ("selall"”, "mm", "no");

hideAll () ;

activate ("all", "", false);

// Copy outline to new MyDrillMap layer
setInPlane (1, "OUTLINE") ;
copyToClipboard() ;

createExtra ("MyDrillMap", "help", "none");
pasteFromClipboard() ;

// convert contour to circle if needed
setCurrentAperture (1) ;

editAperture (apeNumber (), "", "CIR,0.1");
viewZoomTotal () ;

//Create drillmap and copy to MyDrillMap
setInPlane(l, "drill"™, "", "", 1);

//Get path to your symbol file

sSymFile = dbPath("drilltoolmanager.symbol.file");
//This script only replaces the first 10 tools
drillMapReplace (sSymFile, [{1, 2, 3, 4, 5, 6, 7, 8, 9, 10}1);
setInPlane (1, "drill drimap");

copyToClipboard () ;

setInPlane (1, "MyDrillMap"):;

pasteFromClipboard() ;

viewZoomTotal () ;

//Add dimensioning

setCurrentAperture (1) ;

selectAperture () ;

R = apeEnclosingBox () ;

apeCreateCircle (999, 0.1);

dimensioning ("distance", 1.0, [{Point(R.xmin, R.ymax), Point(R.xmax,

R.ymax), Point (R.xmax-R.xmin, R.ymax+10)}], true, 2.0, 3.0, 5.0, 5.0,

5.0, 5.0, 5.0, 0.0, 0.0, 0.0, 3, false, false, null,0 ,0 ,"");

dimensioning ("distance", 1.0, [{Point(R.xmin, R.ymin), Point(R.xmin,

R.ymax), Point(R.xmin-10, R.ymax-R.ymin)}], true, 2.0, 3.0, .0, 5.0,
) .

5.0, 5.0, 5.0, 0.0, 0.0, 0.0, 3, false, false, null,0 ,0 ,""
activate ("all", "", false);
viewZoomTotal () ;

’

Showing All “Promptable” Variable Types

This script uses prompt commands to show a dialog box with all possible Variable
types. Examine the script to find out how to initialize and display Variables in
HyperScript.

:C Note: This dialog allows you to load/save/delete a parameter set (see 11.4.1)
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Actions

1

w

Copy the saved parameterset VHSDemo\ParameterSet\ParameterSet.cfg
to your HOME directory

Restart UcamX

Load the “VHS Demo” Workspace

Click the Show button in the Variables section of the Demo Launch Pad

lé‘.{
Parameter Set ~ E m
This is a dialog cantaining all types ofvaiables
Boolean
Option A w
String ahe
Integer 123
Double 123.456
Double Unit | 123.456
File Mame
I Faoint ¥ 100 ¥ 1480 Pick |
|| Draw fox |0 ¥ 1] Drag |
tpx 100 i 280
Rectangle  xmin -50 ymin |-50 Drag |
¥max 140 ymax | 300 |
Continue Abort

Click on the select arrow and select the saved parameter set “MyParSet”
See how the variables receive the values of the saved parameter set

i
Parameter Set |[Eeree v E m’
This is a dialog containing all types of vaiables
Boolean O
Option B w
String def
Integer 456
Couble 456123
Double Unit |456.123
File Mame
I Faoint ¥ 200 ¥ 100 Pick |
|| Draw fox |4 ¥ a Drag |
thx 150 ¥ 250
Rectangle xmin -30 ymin |-25 Drag |
¥max | 200 ymax [1450 |
Continue Abort

Script name: “Variables with Parameter Set.vhs”

// VHS demo script

// This script shows a dialog containing all variable types
// The dialog uses a saved parameter set

print ("Dialog using pre-defined variables");

sParSet = "MyParSet";

boolean BooleanDef = true;
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String[] OptionsDef = {"A","B"};
String StringDef = "abc";
int IntDef = 123;
double DoubleDef = 123.456;
double DoubleUnitDef = 123.456; //unit is mm
promptStart (sParSet, "Custom Dialog");
promptLabel ("This is a dialog with all types of variables");
Boolean BooleanVar = prompt ("Boolean", BooleanDef);
String OptVar = prompt ("Option", OptionsDef, "A");
String StringVar = prompt ("String", StringDef);
int IntVar = prompt ("Integer", IntDef);
double DoubleVar = prompt ("Double", DoubleDef) ;
double DoubleUnitVar = prompt ("Double Unit", DoubleUnitDef, "mm");
Point flashPt = promptPoint ("Point", Point (100, 150)) ;
Line line = promptLine ("Draw", Line (0, 0, 100, 250));
Rectangle rect = promptRectangle ("Rectangle", Rectangle (-50, 150,
-50, 300));
promptEnd () ;

22.10 Looping a Script

This script allows you to replace all occurrences of a selected painted pad by a
standard aperture or by a complex.

This script was originally implemented as a Learn.

Actions

1 Open the Painted job from HOME:/VHSDemo/Jobs/Models

2 Load the “VHS Demo” Workspace

. | |

3 Click the ¥ putton in the Replace Painted Pads section

4 Drag arectangle around a painted pad. When the mouse is released, the object
inside the rectangular area (and al similar objects) are replaced by a standard or a
complex aperture.
As this script is looping, the dialog box stays on the screen and you are ready to
repeat this action until all painted pads are replaced

5 Click Abort button (or [Esc] key) to terminate the script

Script name: “Models Loop.vhs”

// VHS demo script
// This script replaces all ocurrences of a selected
// painted pad by a standard or complex aperture
// This script needs the Loop flag to be set
setMode ("selall", "mm", "no");
selectWindow ("+", dragRectangle("Select a painted pad"),
null, null);
modelsDefineSelections () ;
// Use return code of modelsCreateStandard (true or false) to
// choose conversion to standard or complex aperture
if (!modelsCreateStandard(0.01)) {
modelsCreateComplex () ;
}
modelsSelect(0.01, 0.01);
modelsReplace (0.01, 0.01);

"i",
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print (apeInfo());
selectAll ("-");

;~ Note: You cannot use the zoom Window function in a loop. Use the
mouse wheel and buttons to zoom in and out on the cursor location

22.11 Running a Standalone Script

This script will convert all copper layers (dpf) of a UcamX job to extended Gerber
(RS-274X) without opening the UcamX application.

Script name “exp274x.vhs

// This script converts copper layers (dpf) of a UcamX job to
// extended Gerber (RS-274X) without opening the UcamX application.

opendJdob (paraml) ;

hideAll () ;
activate ("all", "", false);
activate ("lay", "", true);

output274x ("C:\\ucamco\\UcamxX2016\\env\\dat\\Cad") ;

@ Note: Change the path if UcamX is installed in a different directory

Batch file name “dpfTo274x.bat”

echo on

set str= %1

echo.%$str%

set str=%str:\=\\%

echo.%$str%

for /f "useback tokens=*" %%a in ('%str%') do set str=%%~a
echo.%$str%

VHSExecuter.bat %HOME%\VHSDemo\scripts\exp274x.vhs \""%str%"\"

@ Note: Make sure that your Path environment Variable includes a path
to the VHSExecuter batch file.

Actions:
1 Close UcamX

2 Use Windows Explorer to browse to a folder containing a UcamX job
(job file and dpf layers)

3 Right click on the job file and select “open with”
4 Browse to ...\Home\VHSDemo\batchfiles\pdfTo274x.bat and select it
All layers of the selected job will be converted to RS-274X.
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22.12 Calculate & Export BoardSnapshot data

This script uses standard UcamX functionality to calculate & export BoardSnapshot
data to a text file. It also creates (at the same location) a VHS file with all
BoardSnapshot data formatted as VHS Variables. This file can be imported into VHS
using the BoardSnaplmport script (see 22.13).

@ Tip: Check this script out to learn the java commands for handling files.

Actions
1 Set the ucam.db key bsnap.txt to %p\%n_bsnap.txt

2 To enable Boardsnapshot Product Information output edit your
UcamX2016\envidat\ucam.properties file, look for uibsnap parameters and add
uibsnap_text_th.set: true

Restart UcamX
Open ajob
Load the “VHS Demo” Workspace

Click the Calculate & Export button in the
BoardSnapshot section of the VHSDemo Launch Pad

o O b~ W

The script will show all parameters that are added to your export file.

Script name “BoardSnapExport.vhs”

// VHS demo script
// This script

// - Calculates new Boardsnap data using a filter
// - Prints calculated BS parameters
// - Exports BS parameters to an importable vhs file

// Initial actions:

// Set Ucam.db parameter bsnap.text to $p\%n bsnap.txt

// To set text output default edit UcamX20l6\env\dat\ucam.properties
// look for uibsnap parameters and add "uibsnap text tb.set: true"
// (do not enter the quotes)

// Restart UcamX

// Open a job

// Launch Board Snapshot and specify Setup values

setMode ("selall", "mm", "no");

// Set source and export file

sSource = jobPath() + jobName () + "\\" + jobName () + " bsnap.txt";
sTarget = jobPath() + jobName () + "\\" + jobName () +
" bsnap.txt.vhs";

activate ("all", "", true);

netlistBuild ("job");

// Calculate Board Snapshot Data

boardSnapshot (false, "", true, sSource);

// Convert Board Snapshot Data

sQuote — vv\uvv,.

File file = new File(sSource);

FileInputStream fis = null;

DataInputStream dis = null;

try {
fis = new FileInputStream(file);
// BufferedInputStream is added for fast reading
bis = new BufferedInputStream(fis);
dis = new DatalnputStream(bis);

FileWriter fstream = new FileWriter (sTarget);
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22.13

BufferedWriter out = new BufferedWriter (fstream);

// dis.available() returns 0 i1f the file has no more lines
while (dis.available() != 0) {

sLine = dis.readLine();

iSplit = sLine.indexOf (":");

sVariable = sLine.substring (0, iSplit);

sValue = sLine.substring(iSplit+2,sLine.length());

sValue = sValue.replace ("\\","/");

sVariable = sVariable.replace("."," ");

// print variable to console

print (sVariable + " = " + sValue);

// export variable to file

out.write(sVariable + " = " + sQuote + sValue + sQuote + ";\n");
}
print ("-—————---—————————~ ")
print ("Print/Export ready");

// dispose all the resources after using them

out.close (
fis.close(
bis.close(
dis.close(

’

’

’

)
) ;
)
)

}
catch (FileNotFoundException e) {

e.printStackTrace();

}
catch (IOException e) {

e.printStackTrace();

}

Import BoardSnapshot data

This script allows you to import the BoardSnapshot parameter file from the previous
demo into UcamX.

Actions
1 Load the “VHS Demo” Workspace
2 Click the Import button in the BoardSnapshot section

@ Note: This script contains a dummy print instruction to print 1 variable.
After the import all parameters (300+) are available as VHS Variables

Script name “BoardSnaplimport.vhs”

// VHS demo script
//This script imports Boardsnap parameters in vhs format
//created with the BoardSnapExport script

//Get default location for BSvhs file
sBSvhs = jobPath() + jobName() + "\\" + jobName() + " bsnap.txt.vhs";

//Select BSvhs file
promptStart () ;
sBSvhs = promptFileName ("Select Converted BoardSnap Export file:",
sBSvhs) ;
promptEnd () ;

Visual HyperScript User Manual 80




//Import BS parameters in UcamX as variables
importFile (sBSvhs) ;

//Dummy script to show BS wvariable (s)
print ("job copper top: " + job copper top);
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23 Glossary

.bsh Beanshell Script file

.vhs Visual HyperScript Script file

.hst Packaged Launch Pad file (zipped dialogs & scripts)

Visual HyperScript Scripting language for UcamX

Dialog Box Window used for interaction with the user

Launch Pad Dialog Box containing tabbed windows, sections & buttons
Editable Launch Pad Launch Pad for personal use

Packaged Launch Pad Launch Pad to be used for export to other UcamX user(s) (.hst)
Page Tabbed Window inside a Launch Pad

Section Outlined part of a Page on a Launch Pad

Startup Dialog Optional initial dialog displayed when launching a script

Button Clickable object on a Launch Pad Section or on an interactive dialog
ETSCAM_DAT System Variable referring to folder with UcamX system settings
ETSCAM_CFG System Variable referring to folder with company wide settings
HOME System Variable referring to folder with personal settings
Editor Area Part of VHS Script Editor where scripts are entered/displayed
Tab Page Method of displaying multiple open files in the Editor Area
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